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C H A P T E R

1
1 Setting Up

Congratulations on purchasing your new Power Mac G4 system. This chapter contains 
instructions for setting up your computer and display. 

Positioning the Computer and Display

You can pick up the computer by any of its handles. If your monitor is heavy, be sure to use 
correct lifting techniques when positioning it. Position the computer and display so that
m they are on sturdy, flat surfaces
m the power cable connectors don’t press against a wall or other object
m nothing obstructs air flow in the rear of the display or computer
m the computer’s DVD-ROM or DVD-RAM drive tray has space to open in front

Important  The only way to shut off power completely to your computer and display is to 
disconnect their power plugs from the power source. Make sure the power cords for your 
computer and display are within easy reach so that you can quickly unplug them if necessary.
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Plugging In the Computer

1 Make sure the voltage switch on the back of the computer is set for the kind of voltage 
system to which you are connecting.

The voltage switch must be set correctly to avoid damaging your computer. 

Set the switch to show “115”  for AC voltages in
the 100– 120V range. Set the switch to show
“230”  for AC voltages in the 200– 240V range.

If you need to change the setting, insert a small
screwdriver in this slot and slide the switch.
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Country Switch setting

Bermuda, Canada, Jamaica, Japan, Mexico, Philippines, Puerto Rico, 
Saudi Arabia, Taiwan, United States, Venezuela

115

Bahrain, Brazil, France, Indonesia, Italy, Lebanon, Peru, South Korea, 
Spain1

115 or 230

Argentina, Australia, Austria, Belgium, Bosnia and Herzegovina, Chile, 
China (People’s Republic including Hong Kong), Croatia, Czech 
Republic, Denmark, Egypt, Finland, the Former Yugoslav Republic of 
Macedonia, Germany, Greece, Greenland, Hungary, Iceland, India, 
Iran, Ireland, Israel, Jordan, Kuwait, Liechtenstein, Luxembourg, Malta, 
Nepal, the Netherlands, New Zealand, Northern Ireland, Norway, 
Oman, Pakistan, Papua New Guinea, Paraguay, Poland, Portugal, Qatar, 
Romania, Russia and the Commonwealth of Independent States (CIS), 
Serbia and Montenegro, Singapore, Slovakia, Slovenia, South Africa, 
Sweden, Switzerland, United Arab Emirates, United Kingdom, Yemen

230

1 These countries employ more than one type of power source voltage. Ask your local power provider which switch setting to 
use for your city or region.

Warning  Setting the voltage for your computer also sets the voltage of the power socket 
for the monitor on the back of the computer. Be sure your monitor can support this 
voltage before plugging it into the computer’s power socket. Use an appropriate adapter 
or voltage converter if one is necessary. (Monitors that connect to the Apple Display 
Connector on the computer’s AGP graphics card automatically draw the appropriate 
voltage and don’t need adapters.) 
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2 Plug the power cord firmly and completely into the recessed power socket marked with the 
symbol ≤ on the back of the computer and plug the other end into a grounded outlet or 
power strip.

Power cord plug

Power cord socket
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3 Connect your monitor cables according to the following illustration:

If your monitor cable has a two-row DB-15 connector, you can purchase a Macintosh-to-VGA 
adapter from an authorized Apple dealer and connect your monitor to the VGA port on the 
computer.

Important  Depending on your monitor, you may have one or more cables to connect. 
Check the instructions that came with the monitor for further setup information.

Monitor power socketUSB ports

Monitor cableADC monitor port ™ VGA monitor port



10 Chapter  1

4 If required, connect your computer to your Ethernet network and connect your modem port 
to a phone line.

5 Connect the keyboard cable to one of the USB ports ( ) on the computer or on your 
monitor, and plug the mouse cable into a USB port on the keyboard.

Ethernet port

Modem port

USB ports on
keyboard (2)

Parts of your computer
may be covered by clear
plastic film that protected
it during shipment. You
can remove the film.Keyboard Mouse
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If you wish, raise the keyboard by lifting it and flipping the foot toward the back. 

6 Turn on your computer by pressing the monitor’s power button or the power button (®) on 
the front of the computer.

Problems?

If you don’t see anything on your screen or you think your computer did not start up 
properly, check these items:
m Is the computer plugged into a power source? If it is plugged into a power strip, is the 

power strip turned on?
m Are the keyboard and monitor cables connected correctly? 
m Is the power button lit on the front panel of the computer and on the monitor? If not, the 

computer or monitor isn’t receiving power.
m Are the brightness and contrast controls on the monitor adjusted correctly? If your 

monitor has brightness and contrast controls, try adjusting them.
m Try restarting your computer. Press the computer power button for approximately 5 

seconds until the computer turns off. Press it again to turn the computer on.
m If you see a blinking question mark on the screen or hear a series of beeps when you turn 

on the computer, see Chapter 5, “Troubleshooting,” on page 73.
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Turning Off the Computer

To turn off your computer:
m Choose Shut Down from the Special menu.

Adjusting Your Monitor

Use the Monitors control panel to adjust the settings for your monitor. For information about 
troubleshooting your display, see “Problems With Your Display” on page 75. For information 
about maintaining your display, see “Maintaining Your Display” on page 86. Additional 
information about using your monitor is available in Mac Help. 

To register a new Apple display with Apple, go to the Apple World Wide Web site:

www.apple.com/register

What’s Next?
m For an overview of your computer’s features, see Chapter 2, “Getting to Know Your 

Computer,” on page 13.
m For more information about using your modem, connecting to a network, or using the 

computer’s other hardware features, see Chapter 3, “Using Your Computer,” on page 35.
m For information about installing additional drives, memory, or PCI cards, or changing the 

computer’s battery, see Chapter 4, “Working Inside Your Computer,” on page 51.

Important  Do not turn off the computer by turning off the switch on a power strip or by 
pulling the computer’s power plug (unless you can’t turn off the computer any other way). 
Your files or system software could be damaged if your computer is not shut down properly.
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2
2 Getting to Know Your Computer

If you’re eager to get started and want to try out a few things, this chapter is for you. It 
provides an overview of your computer’s important hardware and software features. 

Want to create your own video masterpieces? Take a look at iMovie and find out how you can 
edit video on your computer. Learn how QuickTime can help you view live video broadcasts 
from the World Wide Web. And take advantage of the Internet to research information, 
update your software, shop, browse the Web for fun, or just get help when you need it. 

Here you’ll find a great selection of your computer’s features presented and briefly 
explained. Take a test run and see what your Power Mac G4 can do. For more information 
about a specific feature, see Chapter 3, “Using Your Computer,” on page 35, and the online 
explanations in Mac Help (see page 34).
Note: Pictures showing the latest software features may appear slightly different on your 
screen.
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Your Computer at a Glance

DVD-ROM or�
DVD-RAM drive�
�

Reset button�
�

P

Programmer’s�
button

¥

Zip drive�
(optional)

Power button/�
Power-on light

DVD-ROM or�
DVD-RAM drive�
Open button

C

Speaker
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DVD-ROM or DVD-RAM drive

Use DVD discs to view DVD movies, install software, and access information. A DVD-ROM 
drive works with CD-ROM and DVD-ROM discs, DVD-Video discs, and Photo CDs. It also 
plays standard audio discs. A DVD-RAM drive works with all these discs and also allows you 
to record information on DVD-RAM discs. 

C DVD-ROM or DVD-RAM drive Open button

Opens the drive tray.

Zip drive (optional)

Store and back up information on removable Zip disks. You can purchase a Zip drive and 
install it yourself or have an Apple-authorized dealer install it for a fee.

® Power button/Power-on light

Press this button to turn on the computer or wake it from sleep. When the computer is on, 
pressing the power button puts the computer to sleep. A white light indicates that the 
computer is on. A pulsing light indicates the computer is in sleep. 
With some Apple displays, you can also touch or press the monitor power button to turn 
the computer on or off, or put it to sleep.

P Reset button

This button forces the computer to restart. Use the reset button only when you cannot 
restart your computer with any of the recommended methods, such as choosing Restart 
from the Special menu. For more information about when to use the reset button, see 
Chapter 5, “Troubleshooting,” on page 73.

¥ Programmer’s button

This button interrupts the normal operation of the computer’s software. You will use this 
button rarely or never, only when firmware updates are required for your system. 
Directions for using this button are included in the firmware update documentation. 
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Ports and Connectors—Expanding Your Computer’s Capabilities

Lockable cover latchFireWire ports (2)

Internal modem port�
(optional)

Power socket

Monitor power socket

Sound input port

USB ports (2)

Ethernet portG

≈ W

≤

Access covers for�
expansion slots�
(Slots 2– 4: PCI)Security lock portF

Sound output port-

ADC monitor port

VGA monitor port�
(Slot 1: AGP)

™
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FireWire ports

Connect your Macintosh to FireWire devices, including digital video cameras, scanners, 
hard disk drives, and more. You can connect up to 63 devices and FireWire provides a high-
speed method of data transfer between them all.

G 10/100/1000 twisted-pair Ethernet port 

Connect your Macintosh to a high-speed Ethernet network so that you can access network 
resources such as printers and servers, and share information with other computers over 
the network.

USB ports

Connect your Macintosh to USB devices, such as keyboards, mouse devices, printers, 
scanners, speakers, USB hubs, and more. Your monitor may also have USB ports for 
connecting USB devices.

≈ Sound input port

Connect your Macintosh to an Apple PlainTalk microphone or other audio input 
equipment so that you can record sounds and music.

- Sound output port

Connect your Macintosh to headphones, externally powered (amplified) speakers, or other 
audio output equipment.

F Lockable cover latch and security lock port

You can attach a security lock to your Macintosh and to its back panel to secure the 
internal components. When the lockable cover latch is pulled out, you can insert a security 
cable or lock through the opening to prevent the computer cover from opening. See your 
computer products retailer for security lock devices that work with your computer.

W Internal modem port

Connect a phone cord to the internal modem.

Monitor power socket

Provides a convenient place to plug in a monitor power cord instead of plugging the 
monitor into a wall outlet.

≤ Power socket

Connects to the computer’s power cord.

Monitor ports

Connect your Macintosh to monitors that use the Apple Display Connector (ADC) or to 
standard monitors that have a video graphics array ( VGA) connector.

Access covers for expansion slots (3)

Your Macintosh supports up to three peripheral component interconnect (PCI) cards. The 
covered slots, labeled 2, 3, and 4, provide additional expansion capability. In some 
configurations, an Ultra160 low voltage differential (LVD) SCSI card is installed in one of 
these slots.
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Inside Your Power Mac—Your Computer’s Internal Expansion Options

Battery

Slot 1: AGP slot�
(graphics card installed)

SDRAM slots (4)AirPort Card connector

Slots 2–4: 33 MHz PCI slots (3)Drive position 3

Drive position 2

Drive position 1
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SDRAM slots

You can install additional memory in your computer by inserting up to 4 DRAM DIMMs in 
the memory slots. You can expand your computer’s memory up to 1536 MB.

AirPort Card connector

Connects an AirPort Card, which allows your computer to communicate with a wireless 
network.

PCI expansion slots

You can install PCI cards in these slots to expand your computer’s capabilities. For 
example, you can install a SCSI PCI card and then connect and use SCSI devices such as 
scanners, hard disk drives, and Zip drives.

AGP graphics slot

Connects your AGP graphics card, which provides fast graphics processing power to your 
monitor. You can connect a monitor that has an Apple Display Connector or a standard 
VGA connector. To connect two monitors to your computer, you need to install an 
additional PCI graphics card to support the additional monitor.

Battery

Your computer uses a battery that you rarely replace. If you find that your computer is 
having trouble starting up, or that the system date and time are frequently incorrect, you 
may need to replace the battery. For more information, see “Replacing the Battery” on 
page 71.

Hard disk drive carriers

You can install additional hard disk drives in these carriers inside your computer. If you 
have ATA hard disk drives, you can install up to two drives in a single U-shaped carrier. If 
your computer came with one or more SCSI hard disk drives, you can install up to three 
SCSI drives in the drive carriers.

Zip drive expansion bay

You can install a Zip drive in this drive bay. You can purchase one from an Apple-authorized 
dealer.
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QuickTime—Audio and Video on the Internet

Volume control

Play button Favorites drawer�

Quick access to all of your 
QuickTime TV channels. 
Pull the tab at the bottom 
to open and close the 
Favorites drawer.
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What You Can Do

In addition to being able to play video and music files on your Mac, with QuickTime you can 
watch live and recorded Internet broadcasts.

To Get Started

1 Connect to the Internet.

2 Open QuickTime Player.

3 Open the Favorites drawer.

4 Select a channel.

Tips and Tricks

Add additional QuickTime TV channels

Go to www.apple.com/quicktime and click the QuickTime TV link. There you will find all of 
the available QuickTime channels. You can watch a QuickTime TV channel and with one click 
add it to the Favorites drawer in QuickTime Player.

Upgrade to QuickTime Pro to do the following:

m Play back full-screen video and resize movies.
m Create streaming movies.
m Work with more than 30 audio, video, and image formats, including Flash.
m Create, open, edit, and save movies and audio, as easily as copying and pasting.

To Learn More

Internet video is just one of the things you can do with QuickTime. To learn more, start with 
QuickTime Help. To download additional channels, watch the latest movie trailers, and find 
information on setting up your own Internet streaming server, go to the QuickTime Web site 
at www.apple.com/quicktime
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Sherlock 2—Your Internet Search Detective

Search button�

After you type what 
you are looking for, 
click this button to 
start the search.

Sherlock channels�

Search the Internet for 
people, shopping, news, 

Apple info, and more.

Search sites�
Search engines that 
Sherlock uses to search 
the Internet.
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What You Can Do

Sherlock 2 is your search detective and personal shopper on the Internet. It provides an easy 
way to find people, news, and just about anything. Shop for books and music and search 
auction sites, find the best prices—even check product availability.

To Get Started

1 Connect to the Internet.

2 Choose Search Internet from the File menu or double-click the Sherlock icon on the 
desktop.

3 Select a Sherlock channel.

4 Type what you are looking for and click the Search button.

Tips and Tricks

Create your own customized Sherlock search channel

1 Choose New Channel from the Channels menu.

2 Select a name, channel type, and icon.

3 Download Sherlock plug-ins and drag them into the search site list. Or hold down the 
Option key and drag plug-ins from the other search lists to the icon of your new channel.

To Learn More

To learn more about what you can do with Sherlock, open Mac Help and search for 
“Sherlock.” To download additional search plug-ins and find out how you can create your 
own Sherlock plug-in, go to the Sherlock Web site at www.apple.com/sherlock 
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iMovie 2—Create and Edit Your Own Digital Movies

iMovie monitor�

Preview your 
movie or view 

video directly from 
a connected DV 

camcorder. 

Playback controls�

Use these to play the 
movie in the iMovie 
monitor.

Mode switch�

Use this to
switch between 
importing from

a camcorder
and editing.

Timeline 
viewer�

The clip viewer 
and the timeline 
viewer are visual 

timelines for 
assembling and 

editing your 
movie.

Editing 
buttons�
Click these to 
open panels for 
adjusting and
selecting sounds, 
video effects, 
titles (text), and 
transitions. Click 
the Clips button to 
see the shelf. 

Scrubber bar�

Use this to select
sections of video.

Audio tracks�

Lets you work with 
recordings, music, and 
sound effects.

Playhead�

Represents the 
location of the frame 
showing in the iMovie 
monitor. Move the 
playhead to see 
where things appear 
in a movie.

Video track�

Lets you work 
with audio 

contained in
video clips.

Clip viewer�

Shelf�

To make clips part 
of your movie after 
you import them, 
drag them from 
the shelf to the 
clip viewer. 
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What You Can Do

iMovie is an easy-to-use digital video editing software application. With iMovie and a digital 
video camcorder, you can create and edit your own movies. Import video from the camera, 
edit clips, add transitions, titles, sound effects, and music. Then copy the movie to a 
camcorder tape or create a QuickTime movie.

To Get Started

1 Shoot your video, connect the camera to your computer’s FireWire port, and then open 
iMovie.

2 Click the Import button to import movie clips to the shelf, then add them to your movie by 
dragging them to the clip viewer.

3 Assemble and edit your movie in the clip viewer and timeline viewer.

4 Add transitions, titles, sound, and music.

5 When you are finished, choose Export from the File menu.

Tips and Tricks

Share your desktop iMovie with your friends and family

Export your movie as a QuickTime Web movie and then copy the movie to your iDisk 
or use HomePage to create your own iMovie theater so that others can view your movie 
on the Internet.

To Learn More

For more information on using iMovie, see the iMovie Tutorial or iMovie Help. For the 
latest on iMovie, including iMovie updates, additional plug-ins, and a list of compatible 
DV camcorders, go to the iMovie Web site at www.apple.com/imovie 
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iTools—Free Internet Services for Mac Users

Email�
Get your own Mac.com email address. 
It’s easy and free, and works with your 
favorite email clients. 

iDisk
With your very own 20 megabyte storage 
space on Apple’s Internet server, iDisk is 
the easy way to share files over the 
Internet. Using iDisk, you can easily share 
photos and movies, as well as import 
them into your own Web site. 

HomePage�

Build your own personal Web site in three 
easy steps. Create a birth announcement, 
résumé, or photo album, or set up your 
own iMovie theater. Apple will even host 
your Web site on its Internet server, so it’s
always there for the world to see.

�

KidSafe�

KidSafe makes the Internet a safer place 
for your kids. KidSafe gives them access 
to more than 75,000 educator-approved 
Web sites and blocks all the rest. 
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What You Can Do

iTools is a new class of Internet services from Apple created exclusively for Mac users. With 
iTools, you can email your friends, make the Internet safer for your children, and share 
photos and movies. You can even create your own Web site.

To Get Started

1 Connect to the Internet.

2 Go to www.apple.com

3 Click the iTools tab and then click the Free Sign Up button. 

Tips and Tricks

Upload pictures to your iDisk to create custom iCards

You can send iCards with your own custom pictures. Save your images as GIF or JPEG files 
and then copy them to the Pictures folder on your iDisk. Your images will then appear as 
picture choices when you create an iCard in the Create Your Own section.

Start with a HomePage template to create your own Web page in minutes

HomePage has Web page templates that you can modify with your own text and images. For 
example, teachers can use the HomePage education templates to post recent class news, 
homework assignments, and other information for parents. You can also use the HomePage 
photo album and iMovie templates to share your pictures and movies easily with your friends 
and family.

Create an alias of your iDisk for easy access

Instead of connecting to the Web manually to open your iDisk, you can select the icon of 
your iDisk and choose Make Alias from the File menu. Whenever you want to access your 
iDisk, double-click the alias and enter your password. 

Use KidSafe in conjunction with the Multiple Users control panel

Use the Multiple Users control panel to set up your computer for your entire family to share. 
Now you can set up KidSafe for each of your children’s accounts.
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Auto Updating—Automatically Keep Your Mac on the Cutting Edge

Update Now�

Instantly check Apple’s Internet 
servers to see if any updates

are available for your software.
The Software Update control 

panel displays all of the
available updates useful for 

keeping your computer
running smoothly.

Set Schedule�

Set the day of the
 week and time of day to 

check automatically for
software updates.
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What You Can Do

Auto updating uses the Internet to download (and even install) the latest updates, drivers, 
and other enhancements from Apple—automatically. You can even set your Mac to check 
Apple’s server periodically and download and install updated software for you.

To Get Started

1 Connect to the Internet.

2 Choose Control Panels from the Apple menu and then choose Software Updates from the 
submenu.

3 Click the Update Now button.

4 Select the software you want to update and then click Install.

Tips and Tricks

Adjust your Software Updates schedule

If you have an Internet connection that is always on, you can set a schedule for your 
computer so that it checks for software updates at a certain time on specific days of the 
week. If you have a dial-up connection and you are not connected, Software Updates will 
check the next time you connect.

Install new software automatically

You can set up your Mac so that every week it checks for and installs the latest software. Set a 
schedule for your computer to check for software updates and deselect the “Ask me before 
downloading new software” checkbox. 

To Learn More

For more information on using Software Updates, search for “Software Updates” in 
Mac Help. For the latest information on the Mac OS, go to the Mac OS Web site at 
www.apple.com/macos 
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Multiple Users—Turn One Mac Into Many

Accounts�
Set the appearance of 
the user’s environment.
If you want to control 
the user’s access to 
certain applications, 
choose Limited 
or Panels.



Getting to Know Your Computer 31

What You Can Do

With Multiple Users, you can allow up to 40 different users to share a single Mac with their 
own customized settings and private storage space. For example, users can set their own 
desktop picture, sort their views the way they like, bookmark favorite Web sites, and do many 
other things that create, in effect, a personalized Mac for each individual user. You can also 
specify how much access—and liberty to change things—each individual user can have.

To Get Started

1 Choose Control Panels from the Apple menu and then choose Multiple Users from 
the submenu.

2 Turn Multiple User Accounts on.

3 Click the Options button to configure overall multiple user settings such as the Welcome 
message and other options.

4 Click the New User button.

5 Edit the user’s information, access privileges, and applications.

6 Close the Multiple Users control panel.

Each time the computer starts up the login window appears. To go back to the login window 
after another user has already logged in, choose Log Out from the Special menu.

Tips and Tricks

Create a voice print passphrase

Record yourself speaking a phrase such as “My voice is my password.” Your Mac stores your 
voice print for comparison. Later, when you want to log in by speaking your passphrase, your 
Mac analyzes the biometrics of your voice to make sure you are who you say you are. 

To Learn More

For more information on setting up Multiple Users, including creating a voice print 
passphrase, search for “Multiple Users” in Mac Help. For the latest information on the 
Mac OS, go to the Mac OS Web site at www.apple.com/macos 
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Apple.com—Your Starting Place on the World Wide Web

Macintosh
Products Guide

www.apple.com/guide�
For great hardware and software 

products for your Mac, check
 this Web site or look for

 the Mac symbol.

iCards
www.apple.com/icards�
Use the Internet to send greeting 
cards to your friends and family.

iReview
www.apple.com/ireview�
Your personal guide to the 
Internet, with in-depth reviews 
and recommendations of sites 
ranging from news to travel,  
music, and sports.

�
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Apple Support 
www.apple.com/support�
Find the latest troubleshooting 
information, download software 
updates, find information on 
product protection plans, 
and more. 

Apple Hot News 
www.apple.com/news�

Want the latest Apple news straight 
from the source? Check out Apple 
Hot News. You can find information 
on software updates for your Mac 
and third-party software, QuickTime 
hot picks, and information on the 
next big Apple event.

The Apple Store
www.apple.com/store�
Your one-stop shop for the 

latest Apple hardware and software 
products, including select software 

and accessories from our
third-party developers.
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Mac Help—Answers to All Your Macintosh Questions

Search�

Got a question? 
Type it here and 
click Search.
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3
3 Using Your Computer

This chapter provides explanations and procedures for using your Power Mac G4 computer. 
You’ll find instructions for using the important features of your computer, including your 
keyboard and mouse, modem, FireWire ports, USB ports, networking, and more. 

Explanations are provided for
m “Using Your Apple Pro Keyboard and Apple Pro Mouse” on page 36
m “Using USB Devices” on page 38
m “Using FireWire Devices” on page 40
m “Using Your DVD Drive” on page 42
m “Using Your Modem” on page 44
m “Connecting to an Ethernet Network” on page 45
m “Using AirPort Wireless Networking” on page 47
m “Putting the Computer to Sleep to Save Energy” on page 48
m “Attaching SCSI Devices to Your Computer” on page 49
m “Transferring Information Between Two Apple Computers” on page 50
m “Using the Computer as a Server Without a Monitor” on page 50
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Using Your Apple Pro Keyboard and Apple Pro Mouse

You can quickly adjust settings such as volume or eject CD or DVD discs using the keyboard 
controls.

Your Apple Pro Keyboard has “hot” function keys that you can set up to open your frequently 
used applications or documents. For example, you can use hot function keys to open your 
Web browser, word processor, or favorite game. Once applications are open, you can use the 
hot function keys to switch quickly between them.

Assigning Hot Function Keys

Assigning an application to a function key is simple. The first time you press one of the 
function keys, a dialog box appears that lets you assign any of the function keys to an 
application. After that, you can change function key assignments using the Keyboard 
control panel.

Using the Standard Function Keys

You can quickly change a key from a control or hot function key to a standard function key by 
pressing that key and the Fn key at the same time. You can also use the Keyboard control 
panel to reverse the keys so that the standard function keys are primary and the screen 
controls and hot function keys are secondary.

Function keys Volume Down key

Volume Up key

Mute key

Media Eject key
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Using Your Apple Pro Mouse

To position the pointer using your mouse, move the mouse over any suitable surface such as 
your desktop, mouse pad, or other textured surface. (Some smooth, glassy surfaces provide 
less pointer control than others.) To click an object, press down once on the mouse body 
until you feel a click. To double-click an item, press down twice in quick succession. 

You can adjust the feel of your mouse by turning the dial underneath. Turning the dial one 
direction makes the feel of clicking the mouse stiffer; turning it the other way makes clicking 
the mouse easier. 

For More Information About Your Keyboard and Mouse

Additional information on configuring the keyboard controls and hot function keys is 
available in Mac Help. Choose Mac Help from the Help menu and search for “keyboard” or 
“mouse.”

If you run out of room and want to
keep the mouse clicked while you
lift it, click the mouse, then squeeze
the sides with your thumb and
fingers as you lift.

Turn the ring on the bottom of the mouse to “+”  for more
tension, “O”  for medium tension, and “ – ” for less tension.
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Using USB Devices

Your Power Mac G4 comes with two USB ports, which you can use to connect many types of 
external devices, including printers, digital cameras, game pads, joysticks, keyboards and 
mouse devices, and storage devices. USB makes it easy to connect external equipment. Once 
you connect the device, it is ready to use. You don’t need to restart your computer. 

To use a USB device with your computer, connect the device to the computer and install its 
software or configure your computer to work with the device once. From then on, your 
computer automatically loads the correct software whenever you attach the device. 
Note: Apple has already included software to work with many USB devices. In most cases 
you do not need to install the software that came with the device. If, when you connect a 
USB device, your Power Mac G4 cannot find the correct software, it asks you to search the 
Internet to find it.

USB ports (2)
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Connecting Multiple USB Devices

Your Power Mac G4 has two USB ports. If you want to use more than two devices, purchase a 
USB hub. The USB hub connects to an open port on your computer and provides additional 
USB ports (usually four or seven). 

For More Information on USB

Additional information on USB is available in Mac Help. Choose Mac Help from the Help 
menu and search for “USB.” You can also find information on Apple’s USB Web site at 
www.apple.com/usb

For information on USB devices available for your computer, go to the Macintosh Products 
Guide at www.apple.com/guide

USB hub
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Using FireWire Devices

Your computer has two FireWire ports. FireWire is a high-speed data transfer system that lets 
you easily connect and disconnect external devices—such as digital video (DV ) cameras, 
printers, scanners, and hard disks. You can connect and disconnect FireWire devices without 
restarting your computer. 

These are some of the things you can do with FireWire:
m Connect a digital video camera and capture or transfer high-quality video directly to your 

computer. Then you can use video-editing software such as Apple’s iMovie to edit the 
video. Your accessory kit comes with a standard 6-pin to 4-pin FireWire cable that you can 
use to connect most digital video cameras.

m Connect an external FireWire hard disk drive and use it to back up data or transfer files. A 
FireWire hard disk icon appears on your desktop immediately after you connect the drive 
to your Power Mac G4. In addition, most FireWire hard disks get their power from the 
FireWire cable, so there is no need to carry around a power supply.

m If you have a problem with your computer that prevents you from starting up or you want 
to transfer files, you can use FireWire to connect your Power Mac G4 to another computer 
so that your Power Mac G4 appears as an external hard disk on the other computer (a 
feature known as “FireWire target disk mode”).

To use a FireWire device with your computer, connect the device to the computer and install 
any software that came with the device. Your computer automatically senses when you attach 
a new device. 

To start up from a FireWire hard disk that has the Mac OS on it, use the Startup Disk control 
panel to select the FireWire hard disk as the startup drive. If your FireWire hard disk doesn’t
appear or can’t be selected in the control panel, consult the FireWire hard disk vendor for 
updated software drivers.

FireWire ports (2)
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FireWire Target Disk Mode

If you have a problem with your computer that prevents you from starting up or if you just 
want to transfer files between two computers, you can use FireWire to connect your 
Power Mac G4 to another computer and then have it appear as an external hard disk on the 
other computer.

To connect your Power Mac G4 in FireWire target disk mode, follow these steps:

1 Use a standard FireWire cable with a 6-pin connector on each end to connect your 
Power Mac G4 to another FireWire-equipped computer.

2 Start up or restart your Power Mac G4 and immediately hold down the T key.

Your Power Mac G4 display shows the FireWire disk mode indicator, and the Power Mac G4 
internal hard disk icon appears on the desktop of the other computer.

3 When you are finished transferring files, drag the Power Mac G4 hard disk icon to the Trash 
to unmount the drive.

4 Press the power button on the Power Mac G4 to shut it down and then disconnect the 
FireWire cable.

For More Information on FireWire

Additional information on FireWire, including setting up a network of FireWire devices, is 
available in Mac Help. Choose Mac Help from the Help menu, and search for “FireWire.” You 
can also find information on Apple’s FireWire Web site at www.apple.com/firewire

For information on the FireWire devices available for your computer, go to the Macintosh 
Products Guide at www.apple.com/guide

Important  The computer you want to connect your Power Mac G4 to must have FireWire 
version 2.3.3 or later installed. Use Apple System Profiler, available in the Apple menu, to 
check the version of FireWire installed. If you have an older version, check the Apple FireWire 
Web site at www.apple.com/firewire



42 Chapter  3

Using Your DVD Drive

You can install or run software from CD and DVD discs using the DVD drive. You can 
also use your DVD drive to play DVD movies, multimedia on CD-ROM discs, and music 
from audio CDs. 
Note: If you have older software that comes on floppy disks, contact the software 
manufacturer to see if the software is available on a CD-ROM disc or purchase an external 
USB or FireWire floppy disk drive (such as an LS120/SuperDisk) for your Power Mac G4 from 
your Apple dealer or the Apple Store (www.apple.com/store).

Inserting a Disc

To install or use programs from a CD or DVD-ROM disc, follow these steps:

1 With the computer turned on, press the drive button on the outside of the drive.

2 Place a disc in the tray, with the label facing up, and make sure the disc is lying flat in the tray.

3 Push the tray in to close it. 

4 When the icon for the disc appears on the screen, the disc is ready for use.

Inserting a DVD-RAM Disc or Cartridge

1 Press the Open button on the drive door to open it.

2 Insert the disc or cartridge into the drive tray.

Hold the disc as shown. Do not
touch the surface of the disc.

DVD-RAM drive
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Ejecting a Disc or Cartridge

You eject a disc by dragging the disc icon to the Trash, or by pressing the Media Eject key on 
your keyboard. You cannot use the drive button to eject a disc from the DVD drive.

If you are unable to eject a disc, try the following:

1 Shut down the computer.

2 Carefully pull down the door covering the front of the drive tray and locate the small hole 
next to the Open button below the drive tray.

3 Carefully insert the end of a large straightened paper clip into the hole.

4 Push firmly until the tray opens. 

5 Pull out the tray, remove the disc or DVD cartridge, and push the tray in to close it.

Playing DVD and Audio Discs

You can use the DVD drive to play DVD-Video discs on your Power Mac G4. Insert the DVD 
disc and then open Apple DVD Player (in the Applications folder on your hard disk).

To listen to a standard audio CD, use the AppleCD Audio Player program in the Applications 
folder. For help using AppleCD Audio Player, look in the Help menu when AppleCD Audio 
Player is open.

You can also use the AutoPlay section of the QuickTime Settings control panel or the Play 
portion of the Control Strip to control audio CD playback.

For More Information on Your DVD Drive

For instructions on using Apple DVD Player, open the player and then choose Apple DVD 
Player Help from the Help menu.

Additional information on using CD or DVD discs is available in Mac Help. Choose Mac Help 
from the Help menu and search for “discs.”

Push the cartridge into
the drive until the drive
automatically closes.
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Using Your Modem

Your Macintosh comes with an Apple 56K V.90 internal modem installed. 

To connect the Apple 56K V.90 internal modem, plug one end of a phone cord into the 
modem port on the back of the computer and the other end into a standard RJ-11 telephone 
wall jack.

More information about the internal modem is available in Mac Help (in the Help menu).

Using an External USB Modem

To connect an external USB modem, use a USB cable to connect the modem to a free USB 
port on the keyboard, computer, USB monitor, or USB hub.

Check the documentation that came with the modem to see if it needs to be plugged into a 
power outlet. Also look for instructions about installing modem software and connecting the 
modem to a telephone line.

Modem port

Modem port icon

Important  Make sure you connect the internal modem to an analog phone line—the kind 
used typically in homes. The modem will not work with a digital phone line.

Warning  Disconnect your modem from the phone jack during lightning or thunder 
storms. This will prevent a destructive voltage overload from damaging the modem.
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Connecting to an Ethernet Network

Your computer comes with built-in 10/100/1000 megabit per second (Mbps) twisted-pair 
Ethernet networking capability. Connecting to a network gives you access to other 
computers. You may be able to store and retrieve information, use network printers, 
modems, and electronic mail, or connect to the Internet. You can also use Ethernet to share 
files between two computers or set up a small network.

If you’re connecting to an existing network, you may be able to get information about the 
network and the network software you need from a network administrator who oversees its 
operation. Identify your organization’s network administrator before you begin.

Follow these guidelines when selecting a cable for your network:

Connecting to a Twisted-Pair Ethernet Network

You can connect directly to a 10/100/1000 twisted-pair Ethernet network.
Note: You can also connect your computer to an Ethernet network that uses thin coaxial 
cables. To do this, you need an RJ-45–to–Thin Coax adapter (available from other 
manufacturers). See your Apple-authorized dealer for more information on Ethernet media 
adapters.

To connect your Macintosh to a centralized 10/100/1000 twisted-pair Ethernet network, 
follow these steps:

1 Plug one end of an RJ-45 twisted-pair cable into the Ethernet port on your Macintosh.

Type of twisted-pair Ethernet Use twisted-pair cable types

10 Mbit Category 3, 5, or 6

100/1000 Mbit Category 5 or 6
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2 Plug the other end of the cord into an RJ-45 wall outlet or external hub that is connected to a 
twisted-pair Ethernet network.

After you start up the computer, you need to configure the software for your network 
connection. Your network administrator can provide the necessary information. You can also 
get help configuring your network software using Mac Help (in the Help menu).

For More Information on Using Ethernet

Additional information, including setting up an Ethernet network or transferring files using 
Ethernet, is available in Mac Help. Choose Mac Help from the Help menu and search for 
“Ethernet” or “network.”

For information on networking products you can use with your Power Mac G4, go to the 
Macintosh Products Guide at www.apple.com/guide

Ethernet port
(Twisted-pair
Ethernet)

RJ-45 wall plate

Twisted-pair Ethernet cable

Ethernet hub
or switch
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Using AirPort Wireless Networking

AirPort offers an easy and affordable way to provide wireless Internet access anywhere in the 
home, at work, or in the classroom. Instead of using traditional cables, AirPort uses wireless 
local area network (LAN) technology to provide wireless communication between multiple 
computers. Through a wireless network you can set up access to the Internet, transfer files,
play multiplayer games, and more.

Your Power Mac G4 is AirPort-ready. The only thing you need to add is an AirPort Card. You 
install the AirPort Card in a slot inside the computer and connect it directly to the end of a 
built-in antenna cable.

How AirPort Provides Wireless Internet Access

With AirPort, you set up a wireless connection to a device known as a base station, which has 
a physical connection to the Internet. AirPort technology works like a cordless telephone. 
The handset of the cordless phone makes a wireless connection to the base, which is 
connected to the telephone line. Similarly, your computer makes a wireless connection to 
the base station connected to the telephone line or your Ethernet network. 

AirPort Base Station

Telephone or Ethernet connection
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Wireless Network Connections

If you install an AirPort Card, you can
m connect your computer to a computer network that has wireless access
m use your computer to provide network access for other computers using wireless cards
m establish a wireless connection and share information with another computer that has an 

AirPort Card

Check with your network administrator for more information about reaching the network’s
wireless access point. 

If your computer has an optional AirPort Card plugged into the connector on the main logic 
board, it can use the built-in antenna that runs inside the computer case to communicate 
with other computers.

For More Information on AirPort

To purchase an AirPort Card or AirPort Base Station, contact your Apple-authorized dealer or 
go to the Apple Store at www.apple.com/store

Additional information on AirPort is available in Mac Help. Choose Help Center from the 
Help menu and choose AirPort Help. You can also find information on Apple’s AirPort Web 
site at www.apple.com/airport

Putting the Computer to Sleep to Save Energy

Power Mac G4 computers are set to go to sleep after a period of inactivity. Sleep is a state in 
which your computer uses very little power. You can also put the computer to sleep 
whenever you want.
Note: Macintosh Server G4 computers are not set to sleep, but you can set them to do so.

When the computer goes to sleep, it saves its state so that when you wake the computer, 
your programs, documents, and control panel settings are exactly as you left them. You use 
the Energy Saver control panel, part of the computer’s system software, to adjust sleep 
settings. For further energy savings, disconnect the computer from its power source or turn 
off the power strip when the computer is not in use.

Warning  Several kinds of objects placed near the computer can cause interference. See 
the instructions that come with an AirPort Card or AirPort Base Station to learn about 
avoiding interference. You may also find more information in the Apple Technical 
Information Library:  til.info.apple.com
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To put your computer to sleep, you can
m press the power button on the front of the computer
m select a sleep mode in the Energy Settings portion of the Control Strip
m open the Special menu and choose Sleep

When the computer is in sleep, the front panel power button light pulses.

You wake the computer by pressing the power button on the front panel of the computer or 
by pressing a key. With some Apple monitors, you can also use the monitor power button to 
put the computer to sleep and wake it.

Not all PCI cards or replacement AGP cards comply with the computer’s power management 
standards. If you install a non-compliant card, the computer can still enter sleep mode, but it 
will not achieve maximum energy savings. You can use the Apple System Profiler to find out 
whether an installed card is compliant.

For more information about energy-saving options, see Mac Help.

Attaching SCSI Devices to Your Computer

Some Power Mac G4 computer configurations come with an Ultra160 Dual Channel SCSI 
card installed in a PCI slot with one or more internal SCSI hard disks connected to it. You can 
install additional internal SCSI hard disk drives up to a maximum of three drives. It’s
recommended that you connect SCSI Ultra160 LVD hard disk drives only to the internal port 
of the Dual Channel SCSI card. You can also connect external SCSI devices, including older 
drives with slower data transfer rates, to the external port of the Ultra160 Dual Channel SCSI 
card. Because the card has two channels, one connected to the internal port and another 
connected to the external port, connecting older devices to the external port doesn’t slow 
down the transfer rate of the internal hard disk drives. 

Apple recommends that you use only SCSI Ultra160 LVD devices as internal hard disk drives.

To connect older SCSI devices that use a 25-pin or a 50-pin connector—such as Zip drives, 
scanners, or DAT drives—you need to purchase SCSI adapters, or you can purchase and 
install an additional SCSI PCI card to support the devices.

For more information about using different types of SCSI devices with your computer, see 
the Tech Info Library at Apple’s Web site:  til.info.apple.com
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Transferring Information Between Two Apple Computers

If two Apple computers are not connected by a network, you can transfer information 
between them by connecting them with an Ethernet crossover cable (in effect creating a 
small network of just two computers). You connect the cable to each computer’s Ethernet 
port and then turn on file sharing on both computers, or configure the computers’ Ethernet 
settings to create a small network. For more information about configuring such an Ethernet 
connection, see Mac Help. 

You can also connect two Apple computers using a FireWire cable. You can then use FireWire 
target disk mode to transfer files from one computer to another. For more information about 
using FireWire target disk mode, see “FireWire Target Disk Mode” on page 41.

If you have an Internet connection, you can also transfer files via the Internet to your iDisk 
storage area on iTools, where you or another iTools user can download them. For more 
information about iTools, see “iTools—Free Internet Services for Mac Users” on page 26.

Using the Computer as a Server Without a Monitor

You can set up your computer to run as a server without an attached monitor. Follow these 
steps:

1 Follow all the steps described earlier to set up your computer, including connecting a 
monitor, mouse, and keyboard.

2 Configure your server software as follows:
m Configure network access.
m Configure the Apple Network Assistant Security application so the server can be 

controlled.
m Set passwords for access to the server.
m Set AppleShare IP services to start up when the system starts up.
m Set the computer not to go to sleep. Macintosh Server G4 computers are shipped 

this way.

3 Be sure network services are operating properly.

4 Turn off the server and disconnect the monitor.

5 Turn on the server.

When you turn on your server, the AppleShare IP services launch automatically after the 
system starts up. 

If you’re using remote access software, follow the instructions that came with your software 
for logging in to and controlling the server.
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4
4 Working Inside Your Computer

This chapter provides information and instructions for working inside your computer. 

Instructions are provided for the following procedures:
m “Opening the Computer” on page 52
m “Installing Memory” on page 54
m “Installing Internal Storage Devices” on page 56
m “Installing a PCI Expansion Card or Replacing the AGP Card” on page 66
m “Installing an AirPort Card” on page 70
m “Replacing the Battery” on page 71

Warning  Apple recommends that you have an Apple-certified technician install memory, 
PCI expansion cards, and internal storage devices. Consult the service and support 
information that came with your computer for instructions on how to contact an Apple-
authorized service provider or Apple for service. If you install these items yourself, you 
risk damaging your equipment, and such damage is not covered by the limited warranty 
on your computer. See an Apple-authorized dealer or service provider for additional 
information about this or any other warranty question.
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Opening the Computer

1 To shut down your computer, choose Shut Down from the Special menu. Wait five minutes 
to allow the computer’s internal components to cool.

2 Unplug all the cables from the computer except the power cord.

3 Touch the metal PCI access covers on the back of the computer to discharge any static 
charge.

Unplug the power cord.

Warning  Always shut down the computer before opening it to avoid damaging its 
internal components or the components you want to install. Do not open the computer 
or attempt to install items inside it while it is turned on.

Touch the metal
portion of the PCI
port access covers.

Important  Always do this before you touch any parts, or install any components, inside the 
computer. To avoid generating static electricity, do not walk around the room until you have 
finished installing the expansion card, memory, or internal storage device and closed the 
computer.

Warning  The power supply in your computer is a high-voltage component and should 
not be opened for any reason, even when the computer is off. If the power supply needs 
service, contact your Apple-authorized dealer or service provider.
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4 Lift the latch on the side of the computer and gently lower the side panel onto a clean, flat
surface, preferably onto a soft, clean cloth.

Lift the latch to unlock
the side panel.

Gently lower the side
panel until it lies flat.
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Installing Memory

You can install additional dynamic random-access memory (DRAM) in packages called Dual 
Inline Memory Modules (DIMMs) in your computer’s four DRAM DIMM slots on the main 
logic board. You can expand your computer’s DRAM to a maximum of 1536 megabytes (MB). 
To check the amounts of DRAM and video memory installed, use the Apple System Profiler
program.

If you install 512 MB DIMMs they must have 256 megabit (Mbit) devices. You can also install 
256 MB DIMMs that have 256 Mbit or 128 Mbit devices. You can install different size DRAM 
DIMMs in any order in any DIMM slot. To check the compatibility of your DIMMs, see the 
Apple Macintosh Products Guide on Apple’s Web site:  www.apple.com/guide

DIMMs must fit these specifications:
m “PC-100” Synchronous DRAM (SDRAM)
m 3.3 volt ( V )
m 64-bit wide, 168-pin module
m Maximum number of memory devices on a DIMM is 16.
m Unbuffered; do not use registered or buffered SDRAM.
m Height must not exceed 2.0 inches.

Important  DIMMs from older Macintosh computers are not compatible with your Power 
Mac G4. Only “PC-100” DIMMs from recent Power Macintosh G3 and G4 computers and 
servers are compatible. Do not use older DIMMs even if they fit into the DRAM DIMM slots.
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1 Open the ejectors on the DRAM DIMM slots you want to use by pushing down on them.

2 Align a DRAM DIMM in the DRAM slot as pictured and push the DIMM down until the 
ejectors snap into place.

3 Close the computer.

Important  Do not touch the DIMM’s connectors. Handle the DIMM only by the edges.

DRAM DIMM (Your DIMM’s shape and components may vary.)

Ejector
(Your slot may have one or two ejectors.
They should be pushed outward and down
to be in the open position, as shown.) 

The DRAM DIMM is designed to fit into
the slot only one way. Be sure to align the
notches in the DIMM with the small ribs
inside the slot. With the ejectors in the
open position (as shown), push down
on the DIMM until it snaps into place.
The ejectors will automatically close. 

Connectors Notches DRAM slot (1 of 4)

Ribs (inside slot)
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Installing Internal Storage Devices

Your Macintosh has five internal drive bays. Three are in the lower part of the computer and 
two are in front on top. In many configurations, a single hard disk drive occupies a 
computer’s lower bay. One of the upper bays contains a DVD-ROM or DVD-RAM drive, and 
some configurations have an optional Zip drive filling the other upper bay. 

You can add SCSI and ATA disk drives to the empty lower drive bays.

Drives must meet these specifications:
m Width:  3.9 inches (102 mm)
m Depth:  5.7 inches (147 mm)
m Height:  1.0 inches (ATA), 1.6 inches (SCSI)

The computer provides support for the following types of internal storage devices: 
m ATA devices, including ATA, ATA-2, and ATA-3 devices
m Ultra ATA devices
m Ultra-66 ATA devices
m Wide Ultra SCSI devices
m Ultra2 and Ultra160 low voltage differential (LVD) SCSI devices
m ATAPI drives, including CD-ROM, DVD-ROM, DVD-RAM, and Zip drives

For more information about requirements and devices supported, see your Apple-authorized 
dealer and the support section of Apple’s Web site:  www.apple.com/support
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Installing Ultra ATA Drives

Your Macintosh can accommodate two internal 1-inch-high ATA devices in the U-shaped drive 
carrier in drive position 3 in the computer. If your computer has one Ultra ATA drive, it sits in 
the lower portion of this U-shaped drive carrier. You can install a second ATA device in the 
upper part of the carrier.

1 Configure your Ultra ATA drive as the secondary drive (sometimes called the “slave drive” or 
“drive 1”).

The drive that came with your Macintosh is designated the primary drive (sometimes called 
the “master drive” or “drive 0”). Your Macintosh doesn’t work with Ultra ATA devices set for 
cable select mode.

2 Unplug the power cord bundle from the main logic board and the ribbon cable from the 
drive.

Unlock the power cord bundle
plug by pressing the small catch
located on the side of the plug.

Unplug the power cord bundle
from the main logic board.

(Side view)

Unplug the ribbon cable
from the hard disk drive.
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3 Remove the power cord bundle from the drive.

Unplug the power cord bundle
from the hard disk drive. There is
no catch on this plug. The plug is
held tightly in place, so pull firmly.
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4 Remove the low-profile attachment screw from the drive carrier and tilt the carrier up to 
remove it from the computer.

Remove the attachment screw
to release the drive carrier.

Tilt the drive carrier up
and carefully pull it out

of the computer.
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5 Install the ATA drive in the U-shaped bracket.
Note: The tinted screws illustrated below indicate the four low-profile screws that came in 
the computer’s accessory kit. The untinted screws show the screws that came with the new 
drive.

Attach an additional ATA drive (1" high)
to the upper portion of the drive carrier
by screwing it into position on its sides.
Attach the two screws on this side first.

These two
tabs will
bend
inward as
you tighten
these two
screws.

ATA drives that are 1" high are attached
to the lower portion of the drive carrier
from the bottom.

Position the hard disk drive on the drive carrier so that the ribbon cable connector and the
power cord connector are accessible.
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6 Replace the carrier and drive.

7 Reinsert the low-profile attachment screw you removed from the carrier in step 4.

Slide the hard disk drive into the
computer at an angle, and lower

it into position. Make sure the
two tabs on the underside of

the drive carrier engage the
slots on the floor of the computer.

Install the
attachment screw

to secure the drive carrier.
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8 Plug the power cord bundles into the hard disk drives.

Plug the power cord bundles into the hard
disk drives. Be sure to press them
firmly into position.

Tuck the excess power cord
bundle cable around the side
of the hard disk drives.
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9 Reconnect the main power cord bundle to the main logic board and the ribbon cable 
to the drives.

10 Close the computer. 

Plug the power cord bundle back
into the main logic board.

Plug the end of the ATA ribbon
cable back into the bottom ATA
drive. Plug the middle connector
into the top ATA drive.
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Installing Ultra160 LVD SCSI Drives

If your Macintosh has an internal Ultra160 LVD SCSI drive, you can connect up to two more 
internal Ultra160 LVD SCSI drives to the PCI card and cable inside the computer. This cable 
has the required connectors and a built-in terminator, so you don’t need to add one.

If you have one Ultra160 LVD SCSI drive, it is installed in lower drive position 1. The 
computer uses the drive in position 1 to start up.
Note: If your computer doesn’t have a SCSI hard disk drive, you need to install a SCSI PCI 
card in your computer to connect SCSI hard disks.

The procedures for disconnecting and connecting a SCSI hard disk drive and for removing 
and inserting drive carriers are nearly identical to those presented in the ATA drive 
installation instructions on page 57. Follow the ATA drive instructions when installing a SCSI 
drive. However, before installing your SCSI drive, note the following differences:

When you configure your SCSI hard disk drive

Assign a unique SCSI ID number to each new device. A single factory-installed drive uses 
SCSI ID 0; a second factory-installed drive uses SCSI ID 1; and a third factory-installed drive 
uses SCSI ID 2. The SCSI PCI card has been assigned ID 7. If you select one of these numbers 
for a new drive, the drive will not work properly.

When you attach the drive to the carrier

If you’re installing a SCSI drive in a model that came with one SCSI drive, install the new 
drive in position 3 (see “Inside Your Power Mac—Your Computer’s Internal Expansion 
Options” on page 18). Do not install a SCSI drive in the top position of the U-shaped bracket.

SCSI drives that are 1.6" high are attached
to the lower portion of the drive carrier
by screwing it into position on its sides.

SCSI drives that are 1" high are
attached to the lower portion of
the drive carrier from the bottom.

Position the hard disk drive on the drive carrier so that the ribbon cable connector
and the power cord connector are accessible.
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Note: The tinted screws in the previous illustration indicate the four low-profile screws that 
came in the computer’s accessory kit. The untinted screws in the following illustration show 
the screws that came with the new drive.

When you replace the carrier and reconnect the drive cables

Attach additional SCSI drives (1" or 1.6" high) to the two flat drive
carriers by screwing them into position from the bottom.

Position the hard disk drive
on the drive carrier so that
the ribbon cable connector
and the power cord connector
are accessible. Screw the drive
into position with the four screws
supplied with the drive.

If your computer came with a SCSI hard disk drive installed in
drive position 1, and you are installing a SCSI hard disk drive
in drive position 2 or 3, put the ribbon cable on top of the drives.
You can tape the ribbon cable to the tops of the drives with
double-stick foam tape to make the cable lie flat.

SCSI terminator

PCI SCSI card
The ribbon cable may attach to a different position on
the PCI SCSI card, depending on which card you have. 

Make sure all of the power
cord and ribbon cable
connectors are firmly attached
to all of the drives and to the
PCI SCSI card.
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Installing a PCI Expansion Card or Replacing the AGP Card

You can expand the capabilities of your Power Mac G4 by installing cards in its expansion 
slots. The computer has four expansion card slots, three of which accommodate peripheral 
component interconnect (PCI) cards and one that accepts an AGP card.

AGP cards and PCI cards have different connectors, so you cannot insert a PCI card into the 
AGP slot.

About AGP Cards

Your AGP card, installed in slot 1, provides the computer’s monitor port. Slot 1 is designed 
specifically to accept AGP cards that have a 32-bit data width. This 66 megahertz (MHz) slot 
accommodates 3.3 volt ( V ) AGP 1X and AGP 2X cards.

You can replace the card that came with the computer with an AGP 1X card, 2X card, or 4X 
card that also operates at 2X speed. A replacement AGP card must have a driver compatible 
with the Mac OS. Maximum power consumption for a replacement AGP card should not 
exceed 8 watts ( W).

Video memory is supplied by synchronous DRAM (SDRAM) soldered onto the AGP card. 
Standard Macintosh models come with 16 megabytes (MB) of SDRAM video memory.

About PCI Expansion Cards

Your Macintosh has three expansion slots, labeled 2, 3, and 4, which accept PCI cards up 
to 12 inches long. Some models come with a SCSI PCI card installed in one of these slots. 
Install only expansion cards that come with Macintosh driver software and that comply with 
the PCI 2.1 standard.

The three PCI slots can accommodate mixed voltage (5.0 V or 3.3 V ) cards with 32-bit or 
64-bit data widths and a 33 MHz frequency. You can add a 66 MHz card to a PCI slot if the 
card can operate at the lower 33 MHz rate.

Maximum power consumption for all three PCI expansion cards should not exceed 
45 watts ( W). 

Warning  Do not use cards that function only at 66 MHz in these three PCI slots. Damage 
to your equipment could result. If you have a 66 MHz card, check the card’s manufacturer 
to see if it also works at 33 MHz.
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Installing Your Card

Install an AGP card in slot 1 only. Install PCI expansion cards in the slots labeled PCI 2, 3, 
and 4.

1 Remove the screw that holds the port access cover in place, pull out the access cover, and set 
it aside.
m To remove a card that’s installed in the computer, remove the screw that holds the card in 

place and pull the card from the slot.

2 Remove the card that you want to install from its static-proof bag and hold it by its corners, 
taking care not to touch the gold connector or any of the components on the card.

Port access cover

Remove the screw that
holds the port access
cover in place.
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3 Align the card’s connector with the expansion slot and press down until the connector is 
inserted all the way into the slot.

If you’re installing a 12-inch card, make sure the card engages the appropriate guide at the 
front of the computer.

Port access opening

PCI slot

Reinstall the screw to
secure the card in place.

If the PCI card you
are installing is full-length
(12 inches), make sure it fits
in one of these four card guides.
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Press the card gently but firmly until the connector is fully inserted.
m Don’t rock the card from side to side; instead, press the card straight into the slot. 
m Don’t force the card. If you meet a lot of resistance, pull the card out. Check the 

connector and the slot for damage or obstructions, then try inserting the card again.
m Pull the card gently to see if it is properly connected. If it resists and stays in place, and if 

its gold connectors are barely visible, the card is connected. 

4 Reinsert the port access cover screw and tighten it to hold the card in place.

5 Close the computer.

Warning  If you removed a card from your computer and did not install a replacement, 
be sure to place a port access cover over the empty slot. Do not leave an empty slot 
without a cover. An uncovered slot can affect the air flow that cools the computer’s
internal components and cause damage.
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Installing an AirPort Card

1 Position the AirPort Card with the AirPort ID numbers and bar code facing up and insert the 
card into the AirPort Card connector.

2 Carefully attach the coaxial antenna wire to the port on the end of the AirPort Card. 

The antenna wire is usually stowed on the side of the PCI card guide. Don’t bend or crimp 
the wire tightly.

3 Close the computer. 

Plug the antenna wire into the
hole in the end of the AirPort Card.

The antenna wire is stowed here when
not in use.

Insert the AirPort Card– bar code side up– until
it is firmly seated in the connector.

AirPort Card connector
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Replacing the Battery

Your computer has a 3.6 V lithium battery installed on the main logic board. Some signs that 
you need to replace the battery are intermittent problems starting up the computer and 
random changes in its date and time settings. You can purchase a replacement battery from 
an Apple-authorized dealer.

1 Remove the battery from its holder, noting the orientation of the battery’s positive end. (Plus 
and minus are also marked on and near the battery holder.)

Important  Batteries contain chemicals, some of which may be harmful to the environment. 
Please dispose of used batteries according to your local environmental laws and guidelines.

Remove the battery by pulling it
up and out of its holder. You may
need to spread these two tabs
slightly apart to release the battery.
Spread the tabs gently so they
don’t break.
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2 Insert the new battery in the holder, making sure the battery’s positive and negative symbols 
align with those on or near the holder.

3 Close the computer.

Warning  Installing the battery incorrectly may cause an explosion. Be sure the battery’s
positive and negative poles are correctly oriented in the holder. Use only the same type of 
battery or an equivalent recommended by the manufacturer of the original.
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5
5 Troubleshooting 

If you have a problem while working with your computer, here are some things you can try 
right away. 

If the computer won’t respond or the pointer won’t move:

First, make sure the mouse and keyboard are connected.
m Unplug and then plug in the connectors and make sure they are firmly seated.

Then try to cancel what the computer is doing.
m Press the Command (x) and Q keys at the same time to try quitting the current 

application.
m Press the Command (x) and period keys at the same time and, if a dialog box appears, 

click Cancel. 
m If that doesn’t work, hold down the Option and Command (x) keys and then press the 

Esc key. If a dialog box appears, click Force Quit. Restart the computer by choosing 
Restart from the Special menu in the Finder to be sure the problem is entirely cleared up.

m Press the reset button on the front of the computer. (The button is marked with the 
π icon.)

m If that doesn’t work, hold down the power button on the front of the computer for 
5 seconds. After the computer turns off, press the button again to turn it on.

m If all else fails, unplug the power cord to turn the computer off, then replug the power 
cord and use the front panel power button to restart the computer.

m If the problem occurs only when you use a particular program, check with the 
program’s manufacturer to see if it is compatible with your computer.

m If the problem occurs frequently, choose Mac Help from the Help menu. Look at the 
section on how to prevent and solve problems. You may need to check for extension 
conflicts or reinstall your computer’s system software.
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If the computer freezes during startup or you see a continuous flashing 
question mark for more than a minute: 

Turn off your system extensions.
m Start up your computer while holding down the Shift key.

If that does not work, start up using the system software CD. 
m Insert your system software CD and start up while holding down the C key. (Make sure 

the Caps Lock key is not engaged.)
m After the computer starts up, see the troubleshooting information in the onscreen help.

Choose Mac Help from the Help menu. Look at the section on how to prevent and solve 
problems. You may need to check for extension conflicts or reinstall your computer’s
system software.

If the computer won’t turn on or start up:

First, make sure the power cord is connected to a working power source.
m The plug on the power cord must be completely inserted into the computer’s power 

socket and firmly seated for your computer to operate correctly.

Reset the computer’s parameter random-access memory (PRAM).
m Start up the computer and immediately hold down the Command (x), Option, P, and R 

keys until you hear the startup sound a second time. Then select your hard disk as the 
computer’s startup disk using the Startup Disk control panel.

If that doesn’t work, or if you hear tones during startup: 
m If you recently installed additional memory, a PCI expansion card, or other internal 

component, make sure that it is correctly installed and that it is compatible with your 
computer. See if removing it allows the computer to start up.

m Contact an Apple-authorized service provider.

Software Problems

If you have a problem with a software program:
m For problems with software from a manufacturer other than Apple, contact the 

manufacturer.

If you have a problem using your computer or working with the Mac OS: 
m Look at the Help Center (in the Help menu) for instructions and troubleshooting 

information.
m Go to the Apple Support Web site on the Internet for the latest troubleshooting 

information and software updates:  www.apple.com/support
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If you have trouble using wireless communication:
m Make sure you have properly configured the software.
m Make sure the computer or network you are trying to connect to is running and has a 

wireless access point.
m Make sure you are within antenna range of the other computer or the network’s access 

point. Nearby electronic devices or metal structures can interfere with wireless 
communication and reduce this distance. Repositioning or rotating the computer may 
improve reception.

m See AirPort Help (in the Help Center) and the instructions that came with the wireless 
device for more information.

Problems With Your Display

No image appears on the screen.

m Make sure the display and computer are turned on.
m Make sure the cables are connected properly to your computer and the display.
m Make sure your computer is not in sleep. Press the power button or any key to see if the 

computer wakes. 
m Make sure the display brightness and contrast are set properly. Some monitors have 

brightness and contrast controls on or under their front edge.

The screen image appears dim or flickers.

m Adjust the display brightness and contrast settings. Some monitors have brightness and 
contrast controls on or under their front edge. Depending on how dim your monitor 
appears, you may be able to adjust brightness or contrast using the Monitors control 
panel.

m Calibrate the monitor using the Calibrate option in the Monitors control panel.
m The flickering may be caused by interference from a nearby power line, a fluorescent

light, or an electrical device—for example, a radio, a microwave oven, or another 
computer. Try relocating nearby electrical devices or moving your computer and display.

Warning   If you have a problem with your Apple display and nothing presented in this 
manual solves it, contact an Apple-authorized service provider or Apple for assistance. If 
you attempt to repair the display yourself, any damage you may cause to the display will 
not be covered by the limited warranty on your display. Contact an Apple-authorized 
dealer or service provider for additional information about this or any other warranty 
question.
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No colors appear on the screen or the colors don’t look right.

m Make sure the display is connected firmly to the computer.
m You may want to calibrate your monitor using the Monitors control panel. For more 

information on color and your display, see Mac Help.
m Open the Monitors control panel and make sure your monitor is set to display colors. For 

more information on color and your display, see Mac Help.

After you change the screen resolution, desktop icons move.

m Changing the screen resolution affects the display of information on your screen. The 
operating system may automatically reposition icons after you change the screen 
resolution.

The screen freezes.

m If you are using both Energy Saver and a screen saver program, the screen saver program 
may be conflicting with Energy Saver. Turn off either the screen saver program or Energy 
Saver and restart your computer.

The light on the front of the monitor is flashing.

On some Apple flat panel displays, the power light can display a series of short flashes when 
an error has been detected. 
m If you see a repeating sequence of three short flashes, the monitor is detecting input in 

the wrong video format. Check that your monitor is compatible with your graphics card 
and that you’ve installed the correct monitor software, if your monitor came with 
installation software. 

m If you see a sequence of two short flashes and a long flash, the monitor is detecting a 
problem with a backlighting lamp. Contact an Apple-authorized dealer or service provider. 
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A
A Specifications

Processor and Memory Specifications 

Processor

m PowerPC™ G4 processor, 1 megabyte (MB) backside cache per processor (some 
configurations have dual processors)

Random-access memory (RAM)

m Minimum of 64 megabytes (MB) of Synchronous Dynamic Random-Access Memory 
(SDRAM), maximum of 1536 MB

m All SDRAM is supplied in removable Dual Inline Memory Modules (DIMMs).
m Four slots are available for DIMMs that are 

m “PC-100” SDRAM DIMMs 
m 32, 64, 128, 256, or 512 MB DIMMs
m Any 256 MB DIMMs you use must have 128 or 256 megabit (Mbit) technology devices; 

512 MB DIMMs must have 256 Mbit technology devices.
m 3.3 volt ( V ) unbuffered, 64-bit wide, 168-pin

The Mac OS system software provides information about your computer, including the 
amount of memory.

Dimensions and Operating Environment 

Dimensions

m Weight:  13.6 kg, 30 lbs.
Weight includes basic configuration, DVD-ROM or DVD-RAM drive, and one hard disk 
drive. Weight may be greater if optional devices are installed.

m Height:  432 mm, 17.0 in.
m Width:  227 mm, 8.9 in.
m Depth:  468 mm, 18.4 in.
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Operating environment

m Operating temperature:  10° to 35° C (50° to 95° F)
m Storage temperature: –40° to 47° C (–40° to 116.6° F)
m Relative humidity:  5% to 95% (noncondensing)
m Altitude:  0 to 3048 meters (0 to 10,000 feet)

DVD-ROM Drive Specifications

m Disc diameters supported:  12 cm (4.7 in.)

Data capacity

m CD-ROM:  656 MB, Mode 1, 748 MB, Mode 2
m DVD-ROM:  4.70 gigabytes (GB), single-sided, single-layer; 8.5 GB, single-sided,

double-layer; 9.4 GB, double-sided, single-layer; 17 GB, double-sided, double-layer
m DVD-RAM:  4.70 gigabytes (GB), single-sided, single-layer 
m DVD-R:  3.95 GB, single-sided, single-layer
m CD-Audio:  74 minutes and 42 seconds play time

DVD-RAM Drive Specifications (Optional)

m Disc diameters supported:  12 cm (4.7 in.)

Data capacity

m CD-ROM:  656 MB, Mode 1, 748 MB, Mode 2
m DVD-ROM:  4.70 GB, single-sided, single-layer; 8.5 GB, single-sided, double-layer; 9.4 GB, 

double-sided, single-layer; 17 GB, double-sided, double-layer
m DVD-RAM:  2.6 GB, single-sided, single-layer; 4.70 GB, single-sided, single-layer; 5.2 GB, 

double-sided, single-layer; 9.4 GB, double-sided, single-layer
m DVD-R:  3.95 GB, single-sided, single-layer; 4.70 GB, single-sided, single-layer
m CD-Audio:  74 minutes and 42 seconds play time

USB Specifications 

m Two external and one internal Universal Serial Bus (USB) Type A ports
m Each port is on a separate 12 megabit per second (Mbps) USB channel.
m 500 milliamperes (mA) at 5 V is available per port for a total of 1 ampere.

FireWire Specifications 

m Main logic board:  Two external standard 6-pin FireWire connectors
m Data transfer speed:  100, 200, and 400 Mbps
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Power

m Input voltage range:  8 to 33 V
m Input power range: approximately 1 watt ( W)
m Output voltage range:  approximately 13 to 30 V
m Output power range:  up to 15 W

Ethernet Specifications 

m IEEE 802.3 compliant
m Maximum cable length:  100 meters (m)
m Protocols:  Open Transport, AppleShare, AppleTalk, NetWare for Macintosh, TCP/IP
m Connector:  RJ-45 for 10Base-T, 100Base-TX, and 1000Base-T
m Media, 10Base-T:  Category 3 or higher UTP on 2 pairs up to 100 m
m Media, 100Base-TX:  Category 5 UTP on 2 pairs up to 100 m
m Media, 1000Base-T:  Category 5 and 6 UTP on 4 pairs up to 100 m
m Channel speeds:  IEEE Auto Negotiation of 10Base-T, 100Base-TX, and 1000Base-T

Modem Specifications

Modem

m Data communications standard:  K56Flex and V.90
m Speed:  53 kilobits per second (Kbps)
m Fax standard:  ITU V.17

Specifications for the AirPort Card (Optional)

m Wireless data rate:  11 Mbps maximum
m Range:  Up to 300 feet (data rates may vary depending on environmental conditions)
m Frequency band:  2.4 to 2.5 gigahertz (GHz)
m Radio output power:  15 dBm (nominal)

Compatibility

m 802.11 Direct Sequence Spread Spectrum (DSSS) 1, 2 Mbps standard
m 802.11 HR DSSS 11 Mbps draft standard 
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Audio Input and Output Specifications 

m 16-bit stereo sound with audio sampling rates of 44.1 kilohertz (kHz)

Sound in using the sound input port

m Input impedance:  Greater than 4 kilohms for gains greater than 23 decibels (dB); greater 
than 25 kilohms for gains less than 23 dB

m Maximum input voltage without distortion:  3 volts ( V ) peak-to-peak
m Line-level microphone voltage range:  28 millivolts (mV ) to 2.5 V peak-to-peak

Sound out using the sound output port 

m Full Scale Output level:  3.0 V peak-to-peak with a 5 kilohm load

Noise, distortion, and bandwidth

m Input sound signal-to-noise ratio (SNR) less than 82 dB unweighted (typical) for recording 
to system disk or system main memory

m Output sound signal-to-noise ratio (SNR) less than 80 dB unweighted (typical)
m Distortion:  Total harmonic distortion: 0.08 percent
m Bandwidth:  20 hertz (Hz) to 20 kilohertz (kHz)

Graphics Controller

m Graphics controller: AGP card with Apple Display Connector and VGA connector

Video Display Modes

Your monitor may not support all the resolutions listed here. For technical specifications for 
your specific display, go to the Apple Web site and check the specifications for your product 
listed there:  www.apple.com/store

VGA port

m 640 x 480 at 60, 67, 72, 75, 85, 90, 100, 120 Hz
m 800 x 600 at 56, 60, 72, 75, 85, 90, 100, 120 Hz
m 832 x 624 at 75 Hz
m 1024 x 768 at 60, 70, 75, 85, 90, 100, 120 Hz
m 1152 x 870 at 75 Hz
m 1280 x 960 at 75 Hz
m 1280 x 1024 at 60, 75, 80 Hz
m 1600 x 1200 at 60, 65, 70, 75, 85 Hz
m 1920 x 1080 at 60, 72, 76 Hz
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Apple Display Connector port

m 640 x 480
m 640 x 480 (stretched)
m 800 x 500
m 800 x 600 
m 800 x 512 (pixel doubled)
m 800 x 600 (stretched)
m 832 x 624
m 1024 x 640
m 1024 x 768
m 1024 x 768 (stretched)
m 1280 x 800
m 1280 x 1024
m 1600 x 1024
m 1600 x 1200

Power Supply 

AC line input

m Line voltage/current:  100–120 volts ( V ) alternating current (AC), 8 amperes (A) 
and 200–240 V AC, 4.5 A, root mean square (rms), single phase, manually set by voltage 
selector switch 

m Frequency:  50–60 hertz (Hz)

DC monitor output:

m 4.0 amperes (A) maximum at 28 V DC
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Power Requirements for Devices You Can Connect

Expansion cards

m Maximum power consumption by the AGP card is 8 watts ( W).
m Maximum power consumption by the three PCI cards combined is 45 W.

USB devices

m Each of the computer’s built-in USB ports is allotted 500 milliamperes (mA). 

FireWire devices

m The computer can provide up to 15 W total to the FireWire ports.

System Clock and Battery 

m CMOS custom circuitry with long-life lithium battery. You can replace the computer’s
battery, which can be purchased from an Apple-authorized dealer.
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B
B Safety, Maintenance, and Ergonomics

This appendix provides important information about safety procedures, routine 
maintenance, and ergonomic considerations for using your computer and display.

Important Safety Information

The only way to disconnect power completely from your computer is to unplug the power 
cord from the main power supply. Similarly, to disconnect your display completely, you must 
also unplug its power cable from the computer or other power outlet. Make sure at least one 
end of the device’s power cord is within easy reach so that you can unplug the computer or 
display when necessary.

For your own safety and that of your equipment, always take the following precautions.

Disconnect the power plug from your computer or display if any of the following conditions 
exists:
m the power cord or plug becomes frayed or otherwise damaged
m you spill something into the case
m your computer or display are exposed to rain or any other excess moisture
m your computer or display have been dropped or the case has been otherwise damaged
m you suspect that your computer or display needs service or repair
m you want to clean the computer or display case or screen 
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To prevent accidents and damage to your computer or display, be sure that you always follow 
these instructions:
m Keep your computer and display away from sources of liquids and moisture.
m Don’t set anything on top of the computer or display.
m Keep the computer and display vents free from obstruction.
m Never remove the case from the monitor, or open your computer when it’s running. You 

could come in contact with hazardous voltage.
m During lightning storms, disconnect your modem from the phone jack to prevent a 

destructive voltage overload from damaging the modem.

Your Macintosh is equipped with a three-wire grounding plug—a plug that has a third 
grounding pin. This is a safety feature. Don’t modify the plug to fit into an ungrounded 
outlet. Contact a licensed electrician to replace the outlet with a properly grounded one. Do 
not defeat the purpose of the grounding plug!

Be careful when lifting or moving your computer or monitor. Be sure to use correct lifting 
procedures, lifting with your legs. When carrying the monitor, make sure the monitor is 
facing you. Don’t carry the monitor by its stand.

Electrical equipment may be hazardous if misused. Operation of this product by children 
must always be supervised by an adult. Do not allow children access to the interior of any 
electrical product and do not permit them to handle electrical cables.
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General Maintenance

If you need to clean the computer or display beyond wiping them down with a clean cloth, 
follow these instructions:

1 Turn your computer and display off.

2 Disconnect the computer power cable from the electrical outlet or power strip. If your 
display has a power cable connected to an outlet, disconnect it as well.

3 Disconnect the display’s cables from the computer.

4 Clean the display screen with soft, lint-free paper or cloth dampened with mild soap and 
water. 

5 Wipe the computer or display case surfaces lightly with a clean, soft cloth dampened 
with water.

Don’t use alcohol, aerosol sprays, solvents, or abrasives that might damage the finish
on the case.

Protecting Your DVD-ROM or DVD-RAM Drive

To keep your DVD-ROM or DVD-RAM drive working properly:
m Position your computer so that the drive tray doesn’t bump into anything when it opens.
m Close the drive when you’re not using it.
m Do not put anything on the drive tray when it is open.
m Do not touch the lens with your fingers. Do not wipe the lens with a paper towel or other 

abrasive surface. If you need to clean the lens, see an Apple-authorized service provider 
for a lens cleaner.

m Keep your computer away from any source of moisture.

Warning  Do not spray liquid directly onto the display screen. Liquid could drip inside 
the display and cause electrical shock.
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Maintaining Your Display

To maintain your display and ensure its long life:
m Do not press on the surface of the display screen.
m Do not write on the screen or touch the screen with a sharp object.
m If you will not be using your display and computer for a day or more, turn off the 

computer and display or use Energy Saver.
m Turn off your monitor, turn down the brightness, or use a screen-saver program that dims 

or varies the image on the screen when the computer is idle for a prolonged time. 

Important Ergonomic and Health-Related Information

Here are some guidelines for adjusting the furniture in your office to reduce glare and to 
accommodate your physical size and shape.
m An adjustable chair that provides firm, comfortable support is best. Adjust the height of 

the chair so your thighs are tilted slightly and your feet are flat on the floor. 
The back of the chair should support your lower back (lumbar region). Follow the 
manufacturer’s instructions for adjusting the backrest to fit your body properly.

m When you use the computer keyboard, your shoulders should be relaxed. Your upper arm 
and forearm should form an approximate right angle, with your wrist and hand in roughly 
a straight line. 
You may have to raise your chair so your forearms and hands are at the proper angle to 
the keyboard. If this makes it impossible to rest your feet flat on the floor, you can use a 
footrest with adjustable height and tilt to make up for any gap between the floor and your 
feet. Or you may lower the desktop to eliminate the need for a footrest. Another option is 
to use a desk with a keyboard tray that’s lower than the regular work surface.

m Position the mouse at the same height as your keyboard. Allow adequate space to use the 
mouse comfortably.

m Arrange the monitor so the top of the screen is slightly below your eye level when you’re
sitting at the keyboard. The best distance from your eyes to the screen is up to you, 
although most people seem to prefer 18 to 28 inches (45 to 70 cm). 
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m Position the monitor to minimize glare and reflections on the screen from overhead lights 
and nearby windows. If possible, use a tiltable monitor stand. The stand lets you set the 
monitor at the best angle for viewing, helping to reduce or eliminate glare from lighting 
sources you can’t move.

For more information about health, safety, and maintenance, go to Apple’s World Wide Web 
site:  www.apple.com/about/ergonomics

Thighs tilted slightly

Shoulders relaxed

Screen positioned to avoid
reflected glare

Forearms and hands
in a straight line

Forearms level
or tilted slightly

Lower back supported

Feet flat on the floor

Top of the screen at or slightly
below eye level (You may need
to adjust the height of your
monitor by placing something
under it or by raising your
work surface.)

Clearance under work surface

45– 70 cm (18– 28 in.)
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Communications Regulation Information

FCC Compliance Statement

This device complies with part 15 of the FCC rules. Operation is subject to the following two conditions:  (1) This 
device may not cause harmful interference, and (2) this device must accept any interference received, including 
interference that may cause undesired operation. See instructions if interference to radio or television reception 
is suspected.

Radio and Television Interference

The equipment described in this manual generates, uses, and can radiate radio-frequency energy. If it is not 
installed and used properly—that is, in strict accordance with Apple’s instructions—it may cause interference with 
radio and television reception. 
This equipment has been tested and found to comply with the limits for a Class B digital device in accordance 
with the specifications in Part 15 of FCC rules. These specifications are designed to provide reasonable protection 
against such interference in a residential installation. However, there is no guarantee that interference will not 
occur in a particular installation. 
You can determine whether your computer system is causing interference by turning it off. If the interference 
stops, it was probably caused by the computer or one of the peripheral devices. 
If your computer system does cause interference to radio or television reception, try to correct the interference 
by using one or more of the following measures:
m Turn the television or radio antenna until the interference stops. 
m Move the computer to one side or the other of the television or radio. 
m Move the computer farther away from the television or radio. 
m Plug the computer into an outlet that is on a different circuit from the television or radio. (That is, make 

certain the computer and the television or radio are on circuits controlled by different circuit breakers 
or fuses.) 

If necessary, consult an Apple-authorized service provider or Apple. See the service and support information that 
came with your Apple product. Or, consult an experienced radio/television technician for additional suggestions.
Important  Changes or modifications to this product not authorized by Apple Computer, Inc., could void the 
FCC Compliance and negate your authority to operate the product.
This product was tested for FCC compliance under conditions that included the use of Apple peripheral devices 
and Apple shielded cables and connectors between system components. It is important that you use Apple 
peripheral devices and shielded cables and connectors between system components to reduce the possibility of 
causing interference to radios, television sets, and other electronic devices. You can obtain Apple peripheral 
devices and the proper shielded cables and connectors through an Apple-authorized dealer. For non-Apple 
peripheral devices, contact the manufacturer or dealer for assistance. 
Responsible party (contact for FCC matters only):  Apple Computer, Inc., Product Compliance, 1 Infinite Loop 
M/S 26-A, Cupertino, CA 95014-2084, 408-974-2000.

Industry Canada Statement

This Class B device meets all requirements of the Canadian interference-causing equipment regulations. 
Cet appareil numérique de la Classe B respecte toutes les exigences du Règlement sur le matériel brouilleur 
du Canada. 
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VCCI Class B Statement

Laser Information

Warning  Making adjustments or performing procedures other than those specified in your equipment’s
manual may result in hazardous radiation exposure.
Do not attempt to disassemble the cabinet containing the laser. The laser beam used in this product is harmful to 
the eyes. The use of optical instruments, such as magnifying lenses, with this product increases the potential 
hazard to your eyes. For your safety, have this equipment serviced only by an Apple-authorized service provider. 
If you have an internal Apple CD-ROM, DVD-ROM, or DVD-RAM drive in your computer, your computer is a Class 
1 laser product. The Class 1 label, located in a user-accessible area, indicates that the drive meets minimum safety 
requirements. A service warning label is located in a service-accessible area. The labels on your product may differ 
slightly from the ones shown here. 

Laser Specifications

Laser on pickup unit (when reading a CD)
m Type:  Semiconductor GaAlAs laser
m Wavelength:  790 nm
m Power out of objective lens:  3.3mW
m Beam divergence:  horizontal 12º vertical 35º
Laser on pickup unit (when reading DVD)
m Type:  Semiconductor GaAlAs laser
m Wavelength:  658 nm
m Power out of objective lens:  6 mW
m Beam divergence:  horizontal 8.5º vertical 27º

Exposure to Radio Frequency Energy

The radiated output power of the optional AirPort Card is far below the FCC radio frequency exposure limits. 
Nevertheless, it is advised to use the wireless equipment in such a manner that the potential for human contact 
during normal operation is minimized.

Mouse and Keyboard Information

The Apple optical mouse is a Class 1 LED product. This product complies with the requirements of European 
Directives 72/23/EEC and 89/336/EEC.
It also complies with the Canadian ICES-003 Class B Specification.

Class 1 label Service warning label



Communications Regulation Information 91

High-Risk Activities Warning

This computer system is not intended for use in the operation of nuclear facilities, aircraft navigation or 
communications systems, or air traffic control machines, or for any other uses where the failure of the computer 
system could lead to death, personal injury or severe environmental damage.

ENERGY STAR® Compliance

As an ENERGY STAR® partner, Apple has determined that this product meets the ENERGY STAR® guidelines for 
energy efficiency. The ENERGY STAR® program is a partnership with office product equipment manufacturers to 
promote energy-efficiency. Reducing energy consumption of office products saves money and reduces pollution 
by eliminating wasted energy.

Communications, Telephone, and Modem Regulation Information 

For information on FCC regulations, radio and television interference, and telephone and modem information as 
it relates to this product, see the files in the Communications Regulations folder, inside the Apple Extras folder on 
your hard drive.




